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Chapter 1—Welcome

iClipboard is the ultimate clipboard manager. It keeps a history of everything you copy to the system-wide clip-
board from any application. When you need to go back and paste a clipping from the history, iClipboard ap-
pears from the side of your screen so you can preview and paste any clipping—you're no longer limited to 
pasting just the last thing copied to the clipboard. For a list of new features in this version please visit our web 
site at http://www.chronosnet.com. 

System Requirements
✦ Mac OS X v10.5.8 or later 
✦ 30MB of available disk space
✦ DVD-ROM drive for installation 

Installing iClipboard
To install the software from a DVD:

1) Insert the installation DVD into your computer’s optical drive.

2) Drag and drop the iClipboard application icon into your Applications folder or other folder of your choice.

To install the software from a download:

1) Open the iClipboard disk image on your desktop

2) Drag and drop the iClipboard application icon into your Applications folder or other folder of your choice.

What Gets Installed?

The first time you run iClipboard, the following items will be installed on your hard disk.

✦ iClipboard.prefPane alias. This alias file links to the iClipboard preference pane inside the iClipboard applica-
tion. The iClipboard preference pane shows up in the Mac OS X System Preference application. The alias file is 
located in the “PreferencePanes” folder of your home “Library” folder.

Uninstall iClipboard

The below steps describe how to uninstall all of the components related to iClipboard.

1) Delete the iClipboard application. The iClipboard application was originally installed by you, so you are the only 
one that knows where it is installed. That said, it is likely in your Applications folder.

2) Delete the “Chronos/iClipboard” folder. This folder is where iClipboard stores its database. This is located in the 
“Application Support” folder of your home Library folder.

3) Delete the “iClipboard.prefPane” alias file. This is located in the “PreferencePanes” folder of your home Library 
folder.

4) Delete the “iClipboardService.bundle” file. This file is located in the “Services” folder of your home Library folder.

5) Delete the “com.chronos.iClipboard.plist” file. This file is located in the “Preferences” folder of your home Library 
folder.
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Learning to Use iClipboard 
To learn how to use iClipboard, consult these resources: 

User Guide 

This guide describes iClipboard’s features and shows how to use the program.

Onscreen Help 

Help tags are available for many of the items in iClipboard. To see the help tags, let the mouse pointer rest over 
an item for a couple of seconds. 

Technical Support 

Chronos provides various support options for iClipboard. See http://www.chronosnet.com/Support/index.html 
for technical support options. 

Web Resources 

Go to http://www.chronosnet.com/Products/index.html to get the latest software and updates.

6

http://www.chronosnet.com/Support/in-
http://www.chronosnet.com/Support/in-
http://www.chronosnet.com/Products/index.html
http://www.chronosnet.com/Products/index.html


Chapter 2—Getting Started

iClipboard is little bit unique in that it’s a faceless background application. This means it doesn’t appear in the 
Mac OS X Dock and doesn’t have a menu bar. Instead it runs in the background and only appears when needed.

Launching iClipboard The First Time
The first time you launch iClipboard it performs some basic installation chores and setup. Once this initial setup 
has been done, you will be able to launch and quit iClipboard using the iClipboard preference pane (see the 
next section).

To launch iClipboard the very first time:

1) Double-click the iClipboard application. The application will launch and a tab will appear on the edge of the 
screen.

2) Click the tab. The tab is connected to a window called the Shelf which is described in the next chapter.

 

The first time you launch iClipboard, it is automatically added to the list of Login Items for your user account. 
This means that iClipboard will automatically and conveniently launch each time you restart your computer.

To view/edit your user account’s Login Items:

1) Open the System Preferences.

2) Click the Accounts preference pane.
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3) Select your account.

4) Click the Login Items tab.

Quitting and Launching iClipboard
Because iClipboard is a background application, you can’t quit it from the File menu like you would for most 
applications. Instead, you use the iClipboard preference pane to quit and launch iClipboard

To quit or launch iClipboard:

1) Open the System Preferences.

2) Click the iClipboard preference pane.

3) Move the ON/OFF switch to the OFF position to quit iClipboard. Move the switch to the ON position to launch 
iClipboard.

Changing Whether iClipboard Launches at System 
Startup
You can change at any time whether or not you want iClipboard to be launched automatically whenever your 
computer restarts.

To enable or disable iClipboard launching at system startup:

1) Open the System Preferences.

2) Click the iClipboard preference pane.

3) Select or deselect Enable at system startup.
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Chapter 3—Using iClipboard

iClipboard records everything copied to the system-wide clipboard  (whenever you press Command-C or choose 
Edit > Copy in any application). It will also remember everything copied between computer restarts, so you can 
literally go back weeks in time to find something that you copied. Each recorded item  is called a clipping. 

The Shelf
The Shelf, which appears on the edge of your screen, lists all of the clippings that have been recorded. 

Each clipping appears as a thumbnail that represents the content in the clipping. iClipboard can accurately pre-
sent thumbnails for standard clippings like the following:

✦ Text (including rich text)
✦ Graphics (supports all popular formats including jpeg, tiff, png, pdf, eps, etc.)
✦ Web content (html/web archives)
✦ Movies
✦ Audio
✦ Files

9



If iClipboard encounters a non-standard or proprietary clipping, the following thumbnail will appear:

This symbol simply means that iClipboard can’t display the contents of the clipping, but the clipping is still valid 
and every bit as usable as any other clipping.

The top clipping in the Shelf is always the Empty clipping. The Empty clipping provides a place where you can 
drag new content directly to the Shelf.

To open the Shelf and view the clippings:

1) Click the tab on the Shelf or press the designated open/close shelf hot key. The Shelf will slide out from the side 
of the screen. For more information on the open/close hot key, see Opening/Closing The Shelf Using a Hot Key.

To close the Shelf:

1) Click the tab on the open Shelf. The Shelf will slide closed.

To change the position of the Shelf on the screen:

1) Click the Action button and choose Preferences.

2) Select the General tab.

3) Choose a new screen position from the Position pop-up menu.

To change the width of the Shelf on the screen:

1) Click the Action button and choose Preferences.

2) Select the General tab.

3) Adjust the width slider accordingly.

To change the height of the Shelf on the screen:

1) Click the Action button and choose Preferences.

2) Select the General tab.

3) Choose your desired Shelf height from the Shelf Height pop-up menu. You have the following choices:

• Auto-Adjustable. Choose this option if you want the Shelf to automatically adjust its height according to the 
number of clippings recorded.

• Fixed Large, Fixed Medium, Fixed Small. Choose these options if you want the the Shelf to alway be the 
same height. You can choose to have it fixed at a small, medium, or large size.

• User Adjustable. Choose this option if you want to click and drag the height of the Shelf using the window 
resize control that will appear in the corner of the Shelf. You can resize the Shelf at any time with this option.

To change the behavior of how the Shelf opens/closes:
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Normally, the Shelf opens/closes by clicking on its tab. You can, however, change this behavior so the Shelf 
opens when you move your mouse to the edge of the screen and closes when you move your mouse off of the 
Shelf.

1) Click the Action button and choose Preferences.

2) Select the General tab.

3) Select Turn hiding on

To enable/disable the Shelf:

If you don’t plan on using the Shelf at all, you can disable it at any time and use other features in the software to 
access your clippings.

1) Click the Action button and choose Preferences.

2) Select or deselect Enable Shelf.

Adding Clippings
iClipboard automatically records everything copied to the system-wide clipboard. The means whenever you press 
Command-C or choose Edit > Copy in any application, the copied content is recorded by iClipboard and placed on 
the Shelf. But there are other ways to get content onto the Shelf including dragging content to Shelf and using the 
controls within a clipping to grab selected content.

To drag content to the Shelf:

1) Click and drag content from any application to Shelf. If the Shelf is closed, it will automatically open and you can 
drop the content on any clipping including the Empty clipping. The clipping will be replaced with the new con-
tent.

To control how the Shelf opens when dragging content to the Shelf:

If the Shelf is closed when you drag content to it, the Shelf will need to open automatically for you. You can 
choose to have the Shelf open automatically as soon as the mouse is over the Shelf’s tab or as soon as the 
mouse hits the edge of the screen.

1) Click the Action button and choose Preferences.

2) Select the General tab.

3) Choose either the Dock Tab or Screen Edge option.

To replace a clipping with selected content in the current application:

1) Select some content in your application.

2) Open the Shelf

3) Move your mouse over an existing clipping whose contents you want replaced with the selected content from 
another application or the Empty clipping. A control bar will appear inside the clipping.

4) Click the Grab button.
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Deleting Clippings
The occasion may arise when you want to delete a single clipping from the Shelf (like a password) or delete a bunch 
of clippings at once.

To delete a clipping:

1) Move your mouse over an existing clipping. A control bar will appear inside the clipping.

2) Click the Action button in the control bar and choose Delete.

To delete more than one clipping:

1) Select more than one clipping. Hold down the shift key to select multiple contiguous clippings. Hold down the 
command key to select multiple clippings in a non-contiguous fashion.

2) Click the Action button and choose Delete Selected.

To delete all clippings in the history:

1) Choose “All” from the Projects pop-up menu. 

2) Click the Action button and choose Delete All.

To delete all clippings in the selected project:

1) Choose a project from the Projects pop-up menu.

2) Click the Action button and choose Delete All

Pasting a Clipping Into Another Application
iClipboard keeps a history of everything copied to the system-wide clipboard so you can go back at any time 
and use the clippings again. iClipboard makes it easy to paste clippings into other applications.

To paste a clipping into another application:

1) Switch to the application where you want the clipping pasted and then click in the document where you want 
the clipping pasted.

2) Open the Shelf.

3) Double-click the clipping you want to paste.

TIP: Hold down the Shift key when you press the Paste button to paste rich text as plain text (no style).

To paste a clipping into another application using the Paste button:

1) Switch to the application where you want the clipping pasted and then click in the document where you want 
the clipping pasted.

2) Open the Shelf.

3) Move your mouse over the clipping you want to paste. A control bar will appear inside the clipping.

4) Click the Paste button.
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TIP: Hold down the Shift key when you press the Paste button to paste rich text as plain text (no style).

To paste more than one clipping consecutively:

1) Select more than one clipping. Hold down the shift key to select multiple contiguous clippings. Hold down the 
command key to select multiple clippings in a non-contiguous fashion.

2) Click the Action button and choose Paste Selected.

To paste all the clippings in the current project or the entire history:

1) Choose a project or “All” from the Projects pop-up menu.

2) Make sure that no clippings are currently selected. You can deselect a selected clipping by clicking on it or by 
clicking the Empty clipping.

3) Click the Action button and choose Paste All.

To paste a clipping into another application using drag and drop:

1) Switch to the application where you want the clipping pasted.

2) Open the Shelf.

3) Click and drag the clipping from the Shelf to the document where you want the clipping pasted.

Previewing a Clipping
The Shelf only displays a thumbnail view of each clipping since space is limited. If you need to see a larger ver-
sion of a clipping, you can bring up a preview.

iClipboard can show you previews of the following standard types of clippings:

✦ Text (including rich text)
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✦ Graphics (supports all popular formats including jpeg, tiff, png, pdf, eps, etc.)
✦ Web content (html/web archives)
✦ Movies
✦ Audio
✦ Files

The previews are dynamic in that movies and audio will play, and files will show you a Mac OS X Quick Look 
preview of the file’s contents when available. If iClipboard tries to preview a non-standard or proprietary clip-
ping, the following preview symbol will appear:

This symbol simply means that iClipboard can’t display the contents of the clipping, but the clipping is still valid 
and every bit as usable as any other clipping.

The preview will also show you other pertinent information about the clipping depending upon the type of 
clipping:

✦ The type of clipping (text, graphic, movie, etc.)
✦ The size of the clipping in bytes
✦ The document and application where the clipping came from
✦ The URL where the web clipping came from, i.e. www.chronosnet.com
✦ The date and time the clipping occurred

To control when previews appear:

You can control when previews appear depending upon your own likes/dislikes. You can choose to have the 
preview appear when your mouse rests above a clipping for a short period of time or when you click the clip-
ping.

1) Click the Action button and choose Preferences.

2) Select the General tab.

3) Choose your desired option from the Show Preview pop-up menu.

To preview a clipping:

1) Move your mouse over a clipping or click the clipping (depending upon your preference setting).

To dismiss a clipping:

1) Move your mouse outside the preview window or Shelf and the preview will momentarily dismiss.

Pausing/Resuming Recording
There may be times when you don’t want iClipboard to record data that is copied to the system-wide clipboard. 
In such cases, you can temporarily pause and resume recording from the Shelf with a single click.

To pause recording:

1) Click Pause.
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To resume recording:

1) Click Record.

Opening a Clipping
You can open a clipping in another application if you want to edit the clipping or work with it. iClipboard will 
open the clipping using the default application for the type of data stored in the clipping. For example, a rich 
text clipping will most likely be opened by TextEdit; a jpeg image will most likely be opened by Preview or 
other graphics editing program; and so forth.

To open a clipping:

1) Move your mouse over an existing clipping. A control bar will appear inside the clipping.

2) Click the Action button in the control bar and choose Open.

Setting Limits
iClipboard can conceivably record every clipping copied to the clipboard forever. As you might imagine, doing 
so would consume a lot of memory and disk space. Fortunately, iClipboard lets you limit the total number of 
clipping by quantity or by time period. For example, you can tell iClipboard to only record the most recent 100 
clippings or you can tell iClipboard to only keep clippings from the past week.

You may also want iClipboard to ignore clippings if they are exceedingly large. For example, a graphics designer 
that works with large graphic files may not want iClipboard to record a 50MB image. Likewise, a movie editor 
might not want a 400 MB movie clip recorded since doing so may affect the computer’s performance. iClip-
board lets you choose to record all clippings regardless of size or just those below a certain size.

To limit the total number of recorded clippings:

1) Click the Action button and choose Preferences.

2) Select the General tab.

3) Choose a limit from the Clipboard limit pop-up menu.

To limit the size of clippings that are recorded:

1) Click the Action button and choose Preferences.

2) Select the General tab.

3) Choose a limit from the Ignore clippings pop-up menu.

Opening/Closing The Shelf Using a Hot Key
Some may find it more convenient to open and close the Shelf using a hot key instead of clicking the tab on the 
Shelf.
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To change the hot key that opens and closes the Shelf:

1) Click the Action button and choose Preferences.

2) Select the Hot Keys tab.

3) Click in the Open/Close Hot Key field.

4) Enter a new hot key or click Clear to delete the existing hot key.

Setting Grab and Paste Sounds
Whenever you grab content onto the Shelf (either by dragging or the Grab button), a special grab sound will 
play so you know the content was grabbed. Likewise, whenever you paste a clipping into another application, a 
special paste sound will play. You can change the sound that plays when these events occur or you can turn off 
the sound effect altogether.

To change the grab and paste sounds:

1) Click the Action button and choose Preferences.

2) Select the General tab.

3) Choose a new sound from the Sound pop-up menus.

iClipboard in The Menu Bar
You can optionally turn on or off an iClipboard menu that appears in the menu bar at the top of your screen. 
This menu displays clippings in all of your projects as well as recent clippings from your history. You can use this 
menu to quickly paste any of these clippings into the current application.
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To paste a clipping into another application using iClipboard in the menu bar:

1) Switch to the application where you want the clipping pasted.

2) Click on the iClipboard status menu icon.

3) Choose a clipping from one of your projects or from the list of Recent Clippings.

To show or hide iClipboard in the menu bar:

1) Click the Action button and choose Preferences.

2) Select or deselect Show in the menu bar.

To change the number recent clippings that appear in the iClipboard menu:

1) Click the Action button and choose Preferences.

2) Select the General tab.

3) Choose a limit from the Menu bar limit pop-up menu.
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Chapter 4—Advanced Features

iClipboard has many advanced features that help you manage you clippings and use clippings in useful ways.

Editing Clippings
You can edit text and web clipping directly from the Shelf. This is useful if you need to make a correction or 
change to a clipping before pasting it into another application.

To edit a text or web clipping:

1) Move your mouse over an existing text or web clipping. A control bar will appear inside the clipping.

2) Click the Action button in the control bar and choose Edit.

Creating a Note From a Clipping
If you also use SOHO Notes by Chronos, you can create a new note directly from a clipping. The contents of the 
clipping will automatically be saved inside of the note.

To create a note from a clipping:

1) Move your mouse over an existing clipping. A control bar will appear inside the clipping.

2) Click the Action button in the control bar and choose Create Note. SOHO Notes will launch and a new note will 
be created.

Locking Clippings
You can lock one or more clippings that you want to remain permanently in the history. Locked clippings ap-
pear at the top of the Shelf with a small lock icon to the left of the clipping:

Locked clippings cannot be moved to a different project or deleted until unlocked. You can also set up a project 
so that all clippings in that project are automatically locked.

The Status Bar will indicate the total number of locked clippings for your convenience.
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To lock a clipping:

1) Move your mouse over an existing clipping. A control bar will appear inside the clipping.

2) Click the Action button in the control bar and choose Lock. The clipping will be locked and the lock icon will 
appear to the left of the clipping. The clipping will be moved towards the top of the Shelf since locked clippings 
are always displayed first.

To unlock a clipping:

1) Move your mouse over a locked clipping. A control bar will appear inside the clipping.

2) Click the Action button in the control bar and choose Unlock. The clipping will be unlocked and the lock icon 
will disappear. The clipping will be moved to its natural order in the history. If the, now, unlocked clipping no 
longer belongs in the history due a limit you have set, it will disappear from the list.

To automatically lock all clippings in a project:

1) Choose Edit Projects from the Projects pop-up menu. A sheet for editing projects will appear.

2) Select the Lock button next to the project name. All clippings currently in the project will be switched to locked 
clippings. Any new clippings saved in the project will automatically be locked. If you later deselect the Lock but-
ton, then all clippings in the project will be unlocked.

Assigning Names To Clippings For Pasting
You can assign a name to any clipping so you can later paste the clipping into another application by name. The 
name you assign to a clipping appears beneath the clipping (“Keauhou Reservation”):

To assign a name to a clipping:

1) Move your mouse over a locked clipping. A control bar will appear inside the clipping.

2) Click the Action button in the control bar and choose Edit Name.

To paste a named clipping into another application:

1) Switch to another application such as a word processor, e-mail client, etc.

2) Choose Application Menu > Services, where Application Menu is the name of the application you’re currently in. 

3) Choose iClipboard and then choose the name of the clipping you wish to paste. The contents of the clipping will 
be pasted into the current application.
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SPECIAL SERVICES NOTE. Not all applications support services. Some popular applications like Microsoft Word 
that were originally written using Apple’s Carbon technology do not support services. Most applications that 
were written in Apple’s modern Cocoa do support services. Services are context-sensitive which means even an 
application that does support services may not be able to use all services at all times. For example, if a service is 
going to paste some text, but you’re currently working on a document that can’t be edited, the service will ei-
ther be disabled or won’t show up.

SPECIAL NOTE FOR SNOW-LEOPARD USERS. The Services menu looks and works slightly differently under 
Snow Leopard. Under Snow Leopard, it’s more context-sensitive which means you’ll only see services listed that 
are applicable for the current document. The services are also listed in a single categorized list instead of hierar-
chically by application as shown below:

Snow Leopard also requires that you enable each service that you want to use. This means that you need to 
enable each named clipping individually. Simply choose Services Preferences from the Services menu.

The Keyboard preferences will open in System Preferences and the Services item will be selected.
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You can now simply find the named clipping like “Paste Keauhou Reservation” and make sure it is enabled. It 
will now appear in the Services menu when applicable.

Rapid-Fire Copying/Pasting
Mac OS X only lets you put a single clipping on the system-wide clipboard at a time. This means if you’re copy-
ing and pasting lots of information between applications that you have to switch between applications every 
time you copy or paste something. iClipboard solves this problem by letting you copy multiple items to its clip-
board at a time; switch applications once; and then paste all of the items from the clipboard one at a time. For 
example, you can press a special hot key five different times in your web browser to copy five different para-
graphs, and then you can switch to your word processor and press a special hot key five times to paste the five 
clippings.

To copy and paste multiple clippings without switching applications needlessly:

1) Switch to the application and/or document where you want to copy information.

2) Select the content you want to copy.
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3) Press the special Copy hot key instead of pressing Command-C. A special lightning bolt symbol will appear next 
to the clipping in the Shelf so you know it’s part of a sequence of clippings that you want to rapidly paste into a 
different application.

4) Repeat steps 2 and 3 for each piece of information you want to copy.

5) Switch to the application and/or document where you want to paste all of the clippings and then click in the 
document where you want the clippings pasted.

6) Press the special Paste hot key instead of pressing Command-V. The oldest clipping in the sequence of clippings 
on the Shelf will be pasted and the lightning bolt symbol next to it will disappear.

7) Repeat step 6 for each special clipping on the Shelf. iClipboard will beep if you press the Paste hot key and there 
aren’t any more clippings in the sequence on the Shelf.

To specify the rapid-fire Copy and Paste hot keys:

1) Click the Action button and choose Preferences.

2) Select the Hot Keys tab.

3) Click in the Copy Hot Key field or the Paste Hot Key field.

4) Enter a new hot key or click Clear to delete the existing hot key.

Paste Blaster
Most Mac OS X users are familiar with the Command-Tab hot key which is used to switch between your running 
applications. If you’re familiar with how this Mac OS X feature works, then you already know how to use the 
Paste Blaster. Simply press a special hot key and large previews from your clipboard history will appear on your 
screen. Press the special hot key repeatedly until the clipping you want to paste is selected and presto, the clip-
ping will automatically be pasted into whatever application you're using.

To use the Paste Blaster:

1) Press the Paste Blaster hot key (the default hot key is Option-Command-P). The Paste Blaster window will appear 
and the Cancel button will be selected.
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2) Continue to hold down the modifier keys (Option & Command in this case). As long as these modifier keys are 
held down, the Paste Blaster window will remain on the screen.

3) With the modifier keys held down, repeatedly release and press the main key of the hot key (“P” in this case). 
Each time you press the main key, the selected clipping in the Paste Blaster window will advance. NOTE: you also 
hold down the Shift modifier key to reverse the order that clippings are selected in.

4) Release the modifier keys to paste the currently selected clipping.

To specify the Paste Blaster hot key:

1) Click the Action button and choose Preferences.

2) Select the Hot Keys tab.

3) Click in the Paste Blaster Hot Key field.

4) Enter a new hot key or click Clear to delete the existing hot key.

To enable/disable the Paste Blaster:

1) Click the Action button and choose Preferences.

2) Select/deselect Enable Paste Blaster.

To limit the number of clippings in the Paste Blaster:

1) Click the Action button and choose Preferences.

2) Select the General tab.

3) Choose a limit from the Paste Blaster limit pop-up menu.

Ignoring Applications
You may not want to record clippings from certain applications. For example, you may not want to record the 
passwords that are copied to the system-wide clipboard when you’re using the Keychain Access application 
that is part of Mac OS X. You can tell iClipboard to ignore clippings that originate in any application.

To not record clippings from an application:

1) Click the Action button and choose Preferences.

2) Select the Applications tab.

3) Click Add (+) to add an application that you wish to ignore.

4) Click Delete (-) to remove the selected application from the list of applications being ignored.
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Chapter 5—Projects

iClipboard can record and group clippings into projects that you define. For example, a scientist might switch to 
her  Research project when she’s doing research on the web and switch to her Report project when she’s work-
ing on weekly progress reports. Projects make it possible to compartmentalize your work.

The Project button at the top of the Shelf indicates the project that you’re currently recording into. The Shelf 
shows you all the clipping in the currently selected project.

The default project is “All” which indicates that the Shelf is showing every clipping regardless of which project it 
belongs to. In other words, “All” represents the master history of clippings. When “All” is selected and a clipping 
is recorded, the clipping is not assigned to any project.

To add a new project:

1) Choose Edit Projects from the Projects pop-up menu. A sheet for editing projects will appear.

2) Click Add (+). A new project will be added to the list of projects.

3) Enter the name of your project and press Return.

4) Select the Lock button if you wish for all clippings saved in this project to be automatically locked.

5) Click Done to exit the sheet.

To delete a project:

1) Choose Edit Projects from the Projects pop-up menu. A sheet for editing projects will appear.

2) Select a project in the list.

3) Click Delete (-).

4) Click Done to exit the sheet.

To rename an existing project:

1) Choose Edit Projects from the Projects pop-up menu. A sheet for editing projects will appear.

2) Double-click a project in the list.

3) Edit the name of the project and press Return.

4) Click Done to exit the sheet.

To switch projects:

1) Choose a project from the Projects pop-up menu. The Shelf will display all of the clippings that have already 
been recorded to the selected project.

To move clippings into project:

1) Select the clippings you want to move to a different project. Hold down the shift key to select multiple contigu-
ous clippings. Hold down the command key to select multiple clippings in a non-contiguous fashion.

2) Click the Action button, choose Move To, then choose the project you want to move the selected clippings to.
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To copy clippings into project:

1) Select the clippings you want to copy to a different project. Hold down the shift key to select multiple contigu-
ous clippings. Hold down the command key to select multiple clippings in a non-contiguous fashion.

2) Click the Action button, choose Copy To, then choose the project you want to copy the selected clippings to. 
Since each selected clipping has now been duplicated, it will show up multiple times in the “All” project.

25


